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Course Objective –  

The core objective of this e-book is to learn about Microsoft PowerPoint-

Advance learner. This course e-book is for students, professional or any individual 

who is willing to learn the concept of PowerPoint to create beautiful 

presentation with ease and via more effective way for better outcomes or 

productive gain. Here we learn more about designing presentation, formatting 

text and inserting picture, videos, audios and much more. We designed this 

course for advance student and learner or any individual who willing to learn 

Microsoft Office for career enhancement.   

Preface –  

This is the first edition of book in your hands. This book provides an advance 

guide about Microsoft PowerPoint and its feature to start your professional 

career or can learn these concepts to create office or project presentation with 

more ease. As with rapidly changing and updating world we were trying to 

describe every detail topic in this e-book. We have tries or best to make this e-

book a complete product and it’s gratifying to know that a lot of people agree 

with our approach.  Dear reader, thank you very much for your love and faith. 

Your association makes us feel proud.                                                                                        

Copyright & Disclaimer -  

© Copyright 2018 by LearnInCreation. All content and graphics published in this e-book are the property 

of LearnInCreation. This book can be used for learning purpose and user of this book is prohibited to 

reuse, retain, copy, distribute or republished any content or part of content of this e-book in any manner 

without the written consent of the author or LearnInCreation. 

We continuously build new courses and update content of our website, tutorials or e-books time to time in 

order to build better interactive learning resources for student; however the content may contain error or 

inaccuracies, LearnInCreation provide no guarantee regarding the accuracy or completeness of our 

website or its content, as there is always much more to learn, but if you discover any kind of inaccuracies 

or error in our website, e-books or in any content, please notify us at our mail address. 

learnincreation@outlook.com                                                                                
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Before You Start – 

In this course of Microsoft Office PowerPoint - Advance learner, we cover all 

essential concept of Microsoft PowerPoint. Before proceeding with this course, 

we assume you already learn basic concept of Microsoft PowerPoint and able 

to create a simple presentation with the help of MS-PowerPoint Tools and 

features, if you are beginner kindly first enroll our PowerPoint fundamental 

course and get back here with pre-required knowledge.   

Table of Content – 

 An Introduction 

 Theme 

 The Theme Element 

 Spell Checker 

 Text Box 

 Speak more with picture 

 Insert, Move, Rotate or Resize Image 

 Find And Replace 

 Line spacing 

 Transition 

 Cut Copy Paste your Text 

 Drag And Drop 

 SmartArt 

 Charts 

 Tables  

 Customize your Table 

 Add or Remove Column 

 Videos 

 Audios 
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Microsoft PowerPoint – 

Presentation simply means to present something in front of audience or 
people. Images and picture are strong enough to clarify the complex topic in a 
simple way, a good images is equal to hundreds of words, so it‟s a good 
practice to speak through images and pictures instead of boring text.  

Presentation is become more meaningful if the content is become easy to 
understand for audience or people. Doesn‟t matter you are presenting school 
seminar or a company mission plan you need to clarify your words to your 
audience and here, you need a presentation software to make your plan or 
content good and interactive. 

MS-PowerPoint is a tool or software which allows you to create such 
presentation. It gives you the wide range of features to make your 
presentation beautiful via text, graphics, pictures, videos etc.  

Here, in this course you will learn more about MS-PowerPoint and explore 
your presentation skills. 

What you will learn here? 

Here, in this course you will go to learn lots of interesting skills about 
PowerPoint. If you are serious about your presentation skills then this course 
helps you to enhance your skills. 

 
After completion of this course you are able to build an effective presentation 
which speaks clear to your audience about your message, with the help of 
text, graphics, picture, shapes etc. 
Also you will be able to add or customize slides in your presentation, once you 
completed this course. 
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Theme – 

Themes are actually a unique set of color, font and effects which helps to 
design a slide easily. Its helps to design or formatting our slides quickly 
because everything is already predefined and you only have to apply a 
selected one in your slide. 

The Theme Element – 

Before applying themes in your slides, first you have to know about the 
element of themes. 
Theme element are describe below – 

1. Theme Colors – 

Color element helps to configure a color of a theme. You can change 
the color of the theme, after selecting a theme. 

2. Theme Fonts – 

Font element helps us to set the font in your slide. If you didn‟t like the 
theme predefined fonts, then you can change it as per your desired. 

3. Theme Effects – 

Effect element is responsible for shape, styles, visual effect, shadow 
etc. and if you didn‟t like the predefined set of effect anymore, you can 
customize it manually as per your choice. 

Now, here you learnt all about Theme Element. Next, you need to learn 
customize or change the theme element. 

How will you change the Theme Element? 
 

If you didn‟t find the selected theme element attractive, you can change its 
color, font or effect. To customize the theme element in PowerPoint 13, follow 
these simple steps – 
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 Inside a Design tab, there is a Variant section. To customize the look of your selected 

theme by changing the theme element. 

 Click on drop-down button to change the theme element. 

 A list of Theme element will open. 

 To change the theme color, hover on Color (here you will get a many set of color to 

customize your theme color element). 

 To change the theme font, hover on Font (a range of font will open in listed manner, 

choose any one of your choice and select it to apply). 

 To change the theme effects, hover on Effects (list of effects will open to customize your 

content, images etc. in a theme). 

 You can also customize the Background of the theme if you didn‟t love a default one, 
hover on Background and change the color of background as per your choice or 
requirement. 

 

It‟s, all about Theme Element and in below section you will going to learn Applying Theme in 

presentation. 

 

Applying Themes 

There are some simple steps you have to follow in order to applying theme in 
your presentation or slides – 

 Go to the Design tab and click on it. 

 Here, under Design tab you will see a Theme section. 

 Theme section contains many different themes with different set of color, font, 

effects etc. 

 Select any one of your choice right click over it. 

 For more theme design click on drop down button, located at the right of Theme 

section. 

 If you want to apply selected theme in all slides click on “Apply to All Slide”. 

 If you wish to apply selected theme only in currently working slide click on “Apply 

to Selected Slide”. 

 The selected theme will appear in presentation, and format your font, color etc. to 

make it interactive. 
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Spell Checker – 

Spell checker helps you to reviewing your spelling and grammar mistake in 
your presentation. With the help of spell check tool you can check and correct 
your grammar mistakes. 

Click on Review tab at the top and select the Spelling command. Its helps you 
to find out misspelled word and shows them in right side Spelling panel. Place 
your cursor over it and correct them. Red line under a word shows that it a 
spelling mistake and you have to correct it. 

 

If you are sure that the spelling is right then click on Ignore it button unless 
change it. Grammar mistake are indicated with the help of green or blue line 
under the word or sentence. 

 

Text Box – 

Text box is used to input text in slides. Sometimes you need to enter text in 
your slides, somewhere outside the text layout, here you can use Text box. 

Here are some simple steps to insert the text box and to format it - 

1. Go to Insert tab and click on command of Text box under Text section. 

2. Now, place your cursor where you want to insert text box and click gently. 

3. On clicking text box will get appear at your location in slide. 

4. Now, it‟s a time to adjust its size (resize) by dragging on its sides and corners 

knob. 

5. Type your desired text one you done with adjusting a size. 

6. Change the font, size, color etc. of your text after selecting it. 
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7. You can also use the WordArt to format your text. 

8. A new tab of Format is appearing which allows you to do more editing with your 

text and text box. 

9. Once you finish your editing, click outside the box. 

You can change the position of your text box just by moving it within a slide, to 
move your text box place your cursor at the edge of text box and its change to 
the plus sign with arrow. Click, Hold and Drag the cursor to the desired 
location. 

Speak more with Pictures – 

 

 

Picture speaks more effectively than words. So it a good practice to speak via 
pictures. Also images register easily in human mind, so if you want to register 
you message in your audience mind then use a relevant picture to deliver your 
message. 
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Inserting Pictures – 

Now, you learn what an importance of picture while you are deliver a message 
to an audience. So next step is to insert pictures in your presentation. 

Follow these simple steps to insert an image in your presentation – 

1. If you are going to insert picture in current working slide then its fine, unless first 

select the slide to insert an image. 

2. Next, go to Insert tab and click on Picture command under Images section. 

3. It will open a new dialog box. Select the picture and click on Insert to add it on 

presentation. 

4. Picture will now appear in slide. 

By default, a new dialog box will open with a Picture folder inside library. If 
your image file is present there it‟s fine, unless you can go to your file location 
and select your picture to insert it. 
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Moving and Resizing Your Images – 

Once you insert an image, now you need to resize it. Follow these simple 
steps to resize you image – 

1. Click on an image to select it. 

2. A selection border will now appear at the border of image. 

3. Place your mouse at the edge of the picture and it convert into corner sizing 

knob. 

4. Click on it and drag that knob to adjust the size of image. 

Rotate Your Image – 

If you want to rotate your image and it can be simply done with the help of 
rotatory arrow knob. On selecting an image a selection border will appear, and 
at the upper center you will see a rotatory arrow knob, rotate that arrow to 
rotate an images in desired direction. 

Moving Your Image – 
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Moving your image is same as dragging text. On selecting an image, you will 
see a selection border place your mouse cursor at the border it converts into 
cross arrow (plus sign with arrow at the all side). Click and drag images and 
place it in right location. 

 

Cropping your Images – 

You can crop your inserted images to make it adjustable with size and given 
area. Cropping an image simply means to remove unwanted part from the 
image. 

To crop an image you can follow below steps – 

1. Select the image you wish to crop. 

2. A Format tab will open and inside a Size section, click on Crop command. 

3. Now you will see a black corner at the edge of image. 

4. Drag them in order to remove the unwanted part from images. 

5. Click on Crop command again, and your image will crop. 

Apart from Cropping, you can format your images via giving it styling, border, 
layout, alignment, color, brightness, WordArt etc. All formatting command are 
placed under Format tab. 

Find and Replace – 

The “Find” command helps us to find specific word from the text. Also if in 
your presentation project you misspelled any word which comes repeated 
times so it a long path to figure out it manually and delete and then type the 
correct one. 
So in that case it‟s good to use “Replace” command. So follow these steps to 
find out and to replace the specific word from your presentation. 
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Find – 

To find a specific word or text – 

1. Select the paragraph in a slide, where you wish to find out. 

2. Click on Find button (located in upper right corner in Home menu). 

3. Type your word, you wish to find out. 

4. Click on „Find Next‟ (help to see or highlight the same word written on another place.) 

There is an another way to find out the word from paragraph in a slide – 

 Press Ctrl + F key to activate find command. 

 Type a specific text you wish to find. 

 Follow the button “Find Next” if you want to figure out the same word, unless close the 

dialog box. 

Replace – 

So, above you read about finding specific text or word here you read about 
replacing text or word from your presentation. 
There is two methods to replace your word or text, 

1. Highlight the text. 

2. Click on „Replace‟ command in Home menu. 

3. Type a word in „Find what‟ box you wish to replace. 

4. Type your word in „Replace with‟ box so it can be replace with earlier one. 

5. Click on Replace (If you want to replace it only once in a slide.) or Replace all (If you 

wish to replace the word from entire presentation.) 

6. Click on Close. 

Second and easiest way to replace your text is to – 

 Press Ctrl + H to open the Replace dialog box. 

 Enter your word in Find what or in Replace with box. 

 Hit Replace or Replace all (according to your wish) 
 Close the dialog box. 
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What is Line spacing? 

Line spacing can be defined as an amount of space between the lines in a 
paragraph or in list. PowerPoint allows you to set a line spacing in your 
presentation. To adjust the line space follow these steps – 

1. Select the sentence or paragraph you want to give line space. 

2. Click on Home tab and under the Paragraph section you will find a line spacing 

command. 

3. Click on line spacing command and select the line space from list. 

4. For more accuracy, click on Line Spacing Option from list, a new dialog box of 

Paragraph will open to adjust the space between lines and paragraph. 

Transition – 

Transition helps you to give special effects to your slides not content. It helps 
to animate slides at the time of start. There are some categories in transition 
according to their animation effect, listed below – 

 Subtle 

 Exciting 

 Dynamic 

 

Every category have listed transition effect to applying in your slide. You can select any of your 

choice and insert it in your presentation. 

 

You need to follow these simple steps to applying transition in your slides – 

1. First select the slide, from side thumbnail preview panel. 

2. Next, click on Transition tab. 

3. Here you can choose any transition effect for your slide under Transition to this slide 

section. 

4. For more transition effect click on side drop down menu button. 

5. Choose any of your choice and select it. 
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6. It automatically applying to your slides and give a preview. 

7. If you want to change the transition then select any other transition effect. 

8. If you want the same transition for all slide then click on “Apply to all” command under 

time section. 

Is it possible to customize the Transition effect? 
 

Well, you think about the right question. Yes, you can customize the transition 
effect you selected for you slides. After selecting the transition effect you can 
customize it via Effect option command. 

To customize your effects click on Effect Option command under Transitions 
to this Slide section. On clicking over drop down menu it will open a list of 
modified effect. Select one of your choices and preview the Transition. 

Apart from modifying transition effect you can also add the sound effect at the 
time of slide transition. One more thing, you can do with modification of slides 
is to add duration of transition. 

 

To add sound effect in your slide transition, you just need to follow these 
simple steps – 

 Click on the drop down menu located in front of Sound under Timing section. 

 A list of effect will appear, choose any one effect and select it. 

 Selected effect wills automatically applying to the slide transition. 

 

To adjust the transition duration, you need to set time as per your accordance. 

 

What if you want to remove the Transition from your presentation? 
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Sometimes presentation will be fine without transition. Also in some place we 

want to remove transition after adding it. 

So what would you do to remove a transition from your slides? 

Read the following steps to remove the transitions – 

1. Select the slide from which you wish to remove the transition. 

2. Go to Transition tab and select none from the transition effects list under Transition to 

this slide section. 

 

Working with Text – 

 

 
 

Here, in this lesson you are going to learn formatting your text, align your text, 
cut, copy, paste or drag your text from one place to another. Also you will 
learn to find and replace your text. 
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But before learning all these you need to write text in your slides in order to 
format, align, cut, copy, paste or drag it. 

So, create a simple title slide as we made for you. 
See slide (sample slide in desktop) 
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Cut and Paste your Text – 

 

 

You can cut your text from its original position and paste it to its new position. 
To cut your text from one place and paste it to another place, you need to 
follow these simple steps – 

1. Select the text (a word or sentence) you wish to cut. 

2. Right click on mouse and click on Cut command. 

3. Or you can simply give the command shortcut (Ctrl + X). 

4. Place your cursor in the location where you want to paste your text. 

5. Right click on mouse and click on Paste command. 

6. Or you can give a command shortcut (Ctrl + V). 

Here, in below sample slide you can see that the line on fifth position (see 
above sample slide) is now on sixth position (see below sample slide). The set 
of order is change because fifth line will be cut and paste to new position. 
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Copy and Paste your Text – 

 
 

You can copy your text from its older position and paste it to its new position. 
To copy your text from one place and paste it to another place, you need to 
follow these simple steps – 

1. Select the text (a word or sentence) you wish to copy. 

2. Right click on mouse and click on Copy command. 

3. Or you can simply give the command shortcut (Ctrl + C). 

4. Place your cursor in the location where you want to paste your text. 

5. Right click on mouse and click on Paste command. 

6. Or you can give a command shortcut (Ctrl + V). 
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Here, in below sample slide you can see that slide message 
#ShareYourKnowledge (see above sample slide) is copy and pasted in front 
of copyright message at right side (see below sample slide). 
 
Copy command is useful when you need a same text or sentence at more 
than one place in a same slide. It‟s better to copy and paste your text instead 
of writing it every time. 

Drag and Drop your text – 

You can drag your text from one place to another as you needed. Follow 
these simple steps to drag your text or image – 

 Simply click on a text, a selection border will appear around the text or image. 

 Place your cursor at the border and its convert into a cross arrow move pointer. 

 Click on it and drag the text and place it where you want. 

See the below sample slide, the position of learn tag is drag from its original 
position in second slide. 
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SmartArt – 

Well it‟s a time to add some graphics in your presentation, which makes your 
document more attractive and interactive while reading. 
SmartArt is again a very nice tool, which allows you to speak by use graphics 
instead of text to communicate with your audience more effectively. So it‟s a 
good tool which makes you presentation friendly to viewer. 

How to insert SmartArt? 

Well you ask a valid question, and in a next paragraph you will get a steps to 
insert it in your slide. So follow these simple steps and learn to speak in a 
language of graphics. 

1. First select the slide, and place your cursor where you want to add a graphics. 

2. Second, under an Insert menu you will see a SmartArt command. 

3. On clicking on it, a new dialog box will appear. 

4. On left side you will see a category, select any one of your choice. 

5. Click OK, and it‟s appearing in your document. 

6. Now simply edit it as per your desire. 
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Charts – 

Presentation allows to use charts in your slides and with the help of chart you 
can shows the data in more relevant way. Charts are used to show graphs in 
a reports. There are many types of charts in a PowerPoint to express you data 
more effectively. In the below section you can see a types of charts in 
PowerPoint. 

 

 

Inserting a Charts – 

Perform the following steps to insert a charts in slides – 

1. Select the slide in which you need to insert the charts. 

2. Select a Chart command inside an Illustration section under Insert tab. 

3. A new dialog box will open with a many charts category, select any one relevant 

to data and select it. 

4. A selected chart will get appear in slides. 

5. A spread sheet also appears, with some dummy text. 
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6. Replace this text with your information which is going to see in a graph. 

7. Once you enter the data relevant to chart, click on close to close the dialog box. 

8. The chart with relevant data will appear. 

 
 

You can edit your data anytime, just by clicking on chart and to select the Edit 
data command under Data section inside a Design tab. 
To change or customize a chart style you can simply choose any style of your 
choice from Chart Style section under Design tab. 
 
You can change or customize the chart color, chart layout, chart type etc. just 
by clicking on command under Design tab to give a better appearance to your 
presentation. 

Also, if you want to share your knowledge and experience with others then 
send us your presentation with hashtag #ShareYourKnowledge. If your 
presentation is really good, we share it on our website with your name and 
details. 
 
Because we not only want to learn new skills, we want to share our skills 
also. #ShareYourKnowledge 
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Tables – 

Table are used to show an organize data or to represent a comparison 
between two things. Well, use of table is depending upon the content you 
were using in your slides or presentation, but here we are learning to insert 
and table in presentation. 

Here are some steps you need to follow to insert a table – 

1. Go to the Insert tab and click on Table command under section of Tables. 

2. A new menu will open in front of you with a number of square grid (box). 

3. Move the mouse over the square boxes in order to select the number of columns 

and rows in your table. 

4. Click anywhere in selected square boxes and the table will get appear in your 

current working slides, with selected number of rows and columns. 

There is also a second method to insert a table, which I think really simple. 
But you just need to be preparing for these methods. 

1. First, go to Insert tab and click on Table command. 

2. Second, select Insert table option instead of moving your mouse over square 

grids. 

3. Third, a new dialog box will appear in your screen and you just need to enter 

number of rows and columns you want in your table. Here, you need to be 

preparing about number of columns and rows. 

That‟s it. 

4. A new table will appear in your screen with the selected number of columns and 

rows. Later, if you want to add or subtract and row or columns you can do it. 

Also you can drag (move) your table to anywhere in a slide and place it to it new 

place. 
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Customizing your Table – 

Once you inserted your table, you can customize it anytime. You can 
customize its styles, border, effect etc. Also you can resize your table on click 
and drag from the corner, according to a space or layout. 
You can move your table, you can add or delete an entire columns or row. 
Here, we learn to add or delete an entire row or column. 

 

How to add a Row or Columns in Table? 

To add a row or column in your table you need to proceed through given 
steps– 

1. To insert a row or column you will simply go to Layout tab at the right side of 

Ribbon bar. 

2. Here you will see a section of Rows and Columns. 

3. Under this section you will see a four Insert command. Insert above, Insert 

below, Insert right and Insert left. 

4. Insert above and Insert Below is used to insert column while Insert Right and 

Insert Left used to insert row in a table. 

5. You can simply select the cell and then, insert a new row either on the left or on 

the right side of selected cell. 

6. Similarly, you can insert the column at above or below the selected cell. 

 

 



Microsoft PowerPoint – The Advance Step Microsoft Office facebook.com/@learnincreation 

26 
 

How to delete a Row or Column or an entire Table from 
slide? 

To delete a row or a column or an entire table, you just need to select a cell of 
that row or column, and then click on Delete command inside a Row and 
Column section. 
It will open an option list to you, you will need to choose either you need to 
delete a row or column or an entire table. 

Videos – 

Same as Picture you can also insert Video in your presentation if required. 
PowerPoint allows you to insert the video in your presentation from your 
computer or online. 
To insert a Video you need to click on Video command locate in a Media 
section under Insert tab. 

 
Follow these simples‟ steps to insert the video in your Presentation – 

1. Click on Video command. 

2. Select Video on My PC… option to insert video from computer. 

3. To insert video online click on Online Video option. 

4. A new dialog box will open to insert a video from your computer. 

5. Select the video file and click on Insert button. 

6. Selected video will insert in your presentation. 

7. Now to format you video you can click on video and a new Format tab will 

open. Here you can format video styling, border, shape, effects, correction, color 

etc. 
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Audio – 

Like video, PowerPoint also allows you to inserting Audio in your presentation. 
To insert audio in your presentation simply click on Audio command under 
Media section inside an Insert Tab. 
 
Proceed these simple steps inserting audio in your slides – 

1. Click on Audio command. 

2. Select Audio on My PC… option to insert audio from computer. 

3. To insert audio online click on Online Audio option. 

4. A new dialog box will open to insert an Audio from your computer. 

5. Select the audio file and click on Insert button. 

6. Selected audio will insert in your presentation. 

Now to format you audio icon you can click on it and, and a new Format tab 
will open. Here you can format its styling, border, shape, artistic effects, 
correction, color etc. 

 

Note – 

So, we are at the end of the courses and, I hope you learnt much more about 
MS-PowerPoint We continuously build more courses. Don‟t Stop Learning!  

 

 

 

. 


